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Abstract 

This document leads you through the efficient use of the u-center 

evaluation software, the powerful and easy to use tool from u-blox 
for evaluating and testing GPS/GNSS positioning chips and modules.  
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Preface 

Overview 

u-center is u-blox’ powerful GPS evaluation and visualization tool which can be downloaded free-of-charge from 

our website (www.u-blox.com). This User Guide provides a description of the features of this software. It allows 

end users to assess and test u-blox GPS/GNSS positioning chips and modules for navigation and positioning 
performance.  

The purpose of u-center is to enable users to: 

 Conduct performance tests on u-blox and other GPS devices. 

 Configure u-blox GPS/GNSS positioning chips and modules. 

 Access and download Firmware updates. 

 Test the added performance provided by u-blox’ free AssistNow A-GPS service. 

Using this guide 

This guide assumes, the user has basic computer skills and is familiar with the Windows Graphical User Interface 
(GUI) and GPS/GNSS receiver environments. 

The following symbols are used to highlight important information: 

 An index finger points out key information pertaining to integration and performance. 

 A warning symbol indicates actions that could negatively impact or damage the receiver. 

Technical support 

If you have questions about installing or using u-center please: 

 Read this user’s guide carefully. 

 Check our homepage (http://www.u-blox.com) to ensure that your GPS/GNSS device, firmware and the 

u-center software are the latest versions.  

 Refer to our web based information service and database of Frequently Asked Questions (FAQ). 

Worldwide Web 

Our website (www.u-blox.com) is a rich pool of information. Product information, technical documents and 

helpful FAQ can be accessed 24h a day. 

By e-mail 

If you have technical problems or cannot find the required information in the provided documents, contact the 

nearest of the Technical Support offices by email. Use our service pool email addresses rather than any personal 
email address of our staff. This makes sure that your request is processed as soon as possible. You will find the 

contact details at the end of the document. 

Helpful information when contacting technical support 

When contacting Technical Support please have the following information ready: 

 Receiver type (e.g. LEA-6H), firmware version (e.g. V7.03), and u-center release (e.g. u-center 7.0) 

 Receiver configuration and short description of the application 

 Your complete contact details 

http://www.u-blox.com/
http://www.u-blox.com/
http://www.u-blox.com/
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1 Features 
u-center evaluation software provides system integrators and end users with a quick and simple way to interface 

with u-blox GPS/GNSS chipsets, modules and boards. It enables easy evaluation, performance testing, 
development and debugging of GPS/GNSS positioning chips and modules. u-center allows easy connection to u-

blox products and provides a suite of features to view, log, and analyze performance. The features include: 

 Support for u-blox’ receivers using u-blox positioning technology. u-center can communicate with these 
receivers using either the UBX protocol, or the NMEA-0183 standard protocol. 

 Support for receivers that utilize standard NMEA strings. 

 u-center presents all the information collected during the operation of the GPS/GNSS device. All aspects of 

GPS/GNSS data (position, velocity, time, satellite tracking, etc.) can be monitored and logged under various 

test scenarios for the evaluation of a receiver. u-center software allows analysis of the collected data in order 
to investigate performance issues such as accuracy, road test position and trajectory, satellite tracking, time 

to first fix, etc. All processed data can be captured in ASCII format and ported into popular spreadsheets for 

creating additional plots and statistics. 

 Camera View: photographic data can be stored in the log file together with the navigation data and later be 

replayed in the application. 

 Export data files to Google Earth and Google Maps. 

 Supports AssistNow Online and AssistNow Offline. 

 Data recording and playback function. 

 Structural and graphical data visualization in realtime. 

 Cut and paste export to standard PC application software. 

 Docking views (real-time cockpit instruments): 
Satellite constellation, compass, clock, altimeter, speedometer, GPS and satellite information views. 

 Download firmware updates into GPS/GNSS positioning chips and modules 
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2 Getting started 

2.1 General information about displayed values 

 Longitude and latitude are displayed according to the datum selected in the GPS/GNSS device (usually: WGS-

84). 

 Time is displayed with reference to UTC 

 Elevation is displayed with reference to either MSL (Height above mean sea level or Orthometric Height) or 

to HAE (Height above WGS-84-Ellipsoid). The reference is controlled by the GPS configuration. 

2.2 Connecting a GPS/GNSS device to the PC 

This section assumes that you have purchased a u-blox Evaluation Kit. Should you try to connect a GPS/GNSS 

device to a PC without using the EvalKit, make sure you use appropriate RS-232 level shifters. Connect a serial 
cable between a communications port (COM-port) of a PC and the EvalKit.  

2.3 Installing u-center 

The installation program guides you through the necessary steps for a successful program installation. 

 u-center uses dynamic link libraries (DLL). The installation program will automatically install the 

required DLL’s into the u-center program directory. Should you try to copy a u-center 

installation from one location to another after the installation, make sure you copy the DLL files 
as well. 

After a successful installation, u-center will start up as shown in Figure 1: 

 

Figure 1: Start display 
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2.4 Configuring the serial connection 

u-center stores the serial settings and uses the last configuration when started. When u-center is started for the 

first time, the COM port needs to be initialized. This is typically done in the Receiver Tool Bar (Figure 2). 

 

Figure 2: Receiver tool bar 

 Connect/Disconnect-Button with COM-Port selection arrow 

 Baudrate-Button with baud rate selection arrow 

 Autobauding-button  

 u-center only supports the COM-Settings listed below. All u-blox GPS/GNSS positioning chips and 

modules are pre-configured this way. 

 Parity: None 

 Data Bits: 8 

 Stop Bits: 1 

 Flow Control: none 

2.4.1 COM-Port 

 

Press the arrow in the Connect/Disconnect-Button and select the used COM-Port 

 

2.4.2 Baud rate  

2.4.2.1 Manual selection 

 Does not apply to USB. 

The baud rate can be manually set or automatically detected by using the autobauding 
feature. Press the arrow in the Baud rate-Button to manually select the baud rate. 

As soon as u-center is synchronized to the device, the Connect/Disconnect-Button on the 

Receiver Tool Bar changes color to green (Figure 3) and the display shows information about 
the satellite constellation, signal to noise ratio, time etc (Figure 5). If the baud rate for 

u-center and the device are not set to the same value, the “Communication Information” 

icon changes to red. Refer to section 4 for further information. 

 

Figure 3: COM-Port and Baud rate successfully detected 
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2.4.2.2 Autobauding 

u-center support autobauding. If frequent break errors are detected, u-center will lower the baud rate, in case of 

framing errors, the baud rate is increased until no further errors are detected.  

 

Figure 4 Autobauding button 

 Some serial cards or adapters frequently generate errors. The u-center autobauding may not 

work reliably in this case. If you experience frequent errors, please set the baud rate manually. 

If the device is working correctly, the display will show information about the satellite constellation, signal to 
noise ratio, time, etc (Figure 5) 

 

Figure 5: Start Display after a successful connection  
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3 Concept and philosophy 
Understanding the basic concept behind u-center is important in order to get the highest benefit out of this 

powerful evaluation software. Figure 6 depicts the architecture of the software. The program gets a data stream 
from either a COM port or a logfile and splits this stream into protocol messages. From the messages, relevant 

parameters are extracted and inserted into the current dataset of the database. 

In the current dataset, statistical values of the parameters are calculated. Average, Minimum, Maximum and 
Standard Deviation are calculated for most parameters. If a protocol does not provide a parameter, u-center tries 

to calculate the parameter from the ones that are available. For example if velocity-north and velocity-east are 

available, u-center calculates the speed over ground and course over ground, unless this data is already available 
in the protocol. 

Database

Data
Source

Protocol
Message
Parser

Parameter
Extracter

Calculate
Statistics

Calculate
Parameters
from other
Parameters Table Views

Graphical Views
Docking Views

12:00:01 24 47 50 56 54 47
2C 30 2E 30 30 2C
54 2C 2C 4D 2C 30
2E 30 30 30 2C 4E

12:00:02 24 47 50 56 54 47
 2C 30 2E 30 30 2C
 54 2C 2C 4D 2C 30
 2E 30 30 30 2C 4E
2C 30 2E 30 30 30
2C 4B 2C 4E 2A 33

Console Views
Message View

Data Stream

Messages

Parameters 24 47 50 56 54 47
2C 30 2E 30 30 2C
54 2C 2C 4D 2C 30
2E 30 30 30 2C 00

LogFile.ubx

 

Figure 6: Engine Architecture 

When a new epoch (change in time) is detected, the current dataset is stored as history in the database. This 

history has a limited size. If the size is exceeded u-center keeps only the latest datasets and the oldest ones are 

removed. The history size may be adjusted. Refer to section 3.2.5 for the details 

u-center provides various view classes for observation. Most views take their data from the database, but some 

get their data directly from the message without using the database at all. The other views are updated when 

the database changes. 

 

 Message View Displays a copy of every known message. This view allows observing a single message in 

detail. It may also be used to send and configure the GPS/GNSS device. Refer to Section for 4.5.4 details. 

 Console Views Display the messages in text form. They are particularly useful for users to develop GPS 

firmware code. There is also a wide range of information available, which is useful for evaluation and 

testing. Refer to Sections 4.5.1, 4.5.2 and 4.5.3 for details. 
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 Graphical Views Display parameters from the database in graphical form. Charts (see Section 4.5.10), 
Histograms (Section 4.5.11) and even a Map Overlay (Section 4.5.9) can be created. There are two more 

views (Deviation View and Sky View, see Sections 4.5.13 and 4.5.14) that may be used for statistical 

performance and antenna pattern analysis. 

 Tabular Views Show the parameters of the database in tabular form. They can be freely configured to 

allow customized tables. Refer to Sections 4.5.6 and 4.5.7 for details. 

 Docking Windows Can be docked to the frame of u-center. An analog watch, compass, world map, 

altitude and speed meter are available. There are also docking windows showing the current signal power 

and the constellation of the satellites received by the device as well as a summary of the GPS status. 

 

 Displaying various Views and Docking Windows requires lots of computing power. Minimizing or closing 
them may significantly reduce CPU usage. 

3.1 Color and satellite coding scheme 

In the graphical views and some docking windows, colors are used to indicate data quality. Table 1 shows the 

color-code for graphical views depending on the quality of the navigation solution. 

 

Color Meaning 

+ Yellow Current value 

+ Orange 3D GPS navigation + Dead Reckoning 

+ Green 3D navigation solution 

+ Cyan 2D navigation solution 

+ Magenta Dead Reckoning  

+ Blue Degraded navigation solution  

+ Red No navigation solution 

Table 1: Color-coding scheme for graphical views 



u-center - User Guide 

GPS-SW-08007-C  Concept and philosophy 

  Page 12 of 60 

Table 2 gives the color-coding scheme for the Docking Windows and Sky View. It indicates the state of each 
satellite.  

Color  Meaning 

 Green Satellite used in navigation (with Ephemeris) 

 Olive Satellite used in navigation (with Ephemeris and PPP) 

 Dark Green 
Satellite used in navigation (with aiding data: AssistNow Autonomous, 
AssistNow Online/Offline) 

 Cyan Satellite signal available, available for use in navigation 

 Blue Satellite signal available, not available for use in navigation 

 Red Satellite signal not available 

Table 2: Color-coding scheme for the Docking Windows and Sky View 

Table 3 gives the satellite-coding scheme for the Docking Windows and Sky View. 

Satellite Code System 

Gxx GPS 

Sxx SBAS 

Rxx GLONASS 

Qxx QZSS 

Table 3: Satellite-coding scheme for the Docking Windows and Sky View 

Figure 7 shows the color legend. This is available under: Tools -> Preferences -> Status Colors. 

 

Figure 7: Color-coding scheme for Graphical Views, Docking Windows, and Sky View 
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3.2 Operating modes 

u-center has different operating modes. The mode changes when you open or close a log file or when you make 

an action in the player. To be able to use the record mode you have to create a new file, save to a new file or 
open an existing file. The record and player mode are only available if you have created a new file or when you 

have opened a write-able file. 

Stop
Mode

Recorder
Mode

Player
Mode

Online
Mode

Close/Eject
File

Open/Create
File Stop

Record

Play/Step/ Scan

Stop

Save

 

Figure 8: Relations between operating modes 

3.2.1 Online mode 

In this mode a GPS/GNSS device is directly connected to u-center via a serial port with. u-center can control and 

configure the receiver, it will display the data that the receiver is sending periodically. 

12:00:01 24 47 50 56 54 47
2C 30 2E 30 30 2C
54 2C 2C 4D 2C 30
2E 30 30 30 2C 4E

12:00:02 24 47 50 56 54 47
 2C 30 2E 30 30 2C
 54 2C 2C 4D 2C 30
 2E 30 30 30 2C 4E
2C 30 2E 30 30 30
2C 4B 2C 4E 2A 33

u-center

Database

 

Figure 9: Dataflow in Online Mode  

3.2.2 Stop mode 

In this mode no data from receiver or log file is forwarded to the database and views. u-center is in this mode 
when a log file is open but player and recorder are not active. 

3.2.3 Record mode 

Record Mode is the same mode as the Online Mode, except u-center additionally creates a log file on your disk, 
contacting all the messages sent by the receiver. You enter this mode by creating a new log file or opening an 

existing log file without write protection and pressing the record button. An example of using this mode would 



u-center - User Guide 

GPS-SW-08007-C  Concept and philosophy 

  Page 14 of 60 

be to make overnight measurements and evaluate the data at a later time. u-blox customer support may request 
a log file from you when you are experiencing a problem with one of our receivers. 

12:00:01 24 47 50 56 54 47
2C 30 2E 30 30 2C
54 2C 2C 4D 2C 30
2E 30 30 30 2C 4E

12:00:02 24 47 50 56 54 47
 2C 30 2E 30 30 2C
 54 2C 2C 4D 2C 30
 2E 30 30 30 2C 4E
2C 30 2E 30 30 30
2C 4B 2C 4E 2A 33

u-center

Database

LogFile.ubx

 

Figure 10: Dataflow in Record Mode 

3.2.4 Player mode 

The Player Mode allows replaying a previously recorded log file step by step, in real-time or at an accelerated 

rate. You enter this mode by opening a file and pressing the play, step or scan button. 

12:00:01 24 47 50 56 54 47
2C 30 2E 30 30 2C
54 2C 2C 4D 2C 30
2E 30 30 30 2C 4E

12:00:02 24 47 50 56 54 47
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 54 2C 2C 4D 2C 30
 2E 30 30 30 2C 4E
2C 30 2E 30 30 30
2C 4B 2C 4E 2A 33

u-center

DatabaseLogFile.ubx

 

Figure 11: Dataflow in Player Mode 

3.2.5 Database limitation 

The number of epochs displayed in u-center is limited in order to allow an efficient analysis of large log files. The 
limit is set to 1800 epochs by default. This means if an epoch is available every second you can analyze data for 

up to 30 minutes. After this time the oldest values are discarded. Data stored to a log file is not affected by the 

database limitation. The number of epochs displayed in u-center can be reset through the menu bar as follows: 
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 For long-term observations, it’s recommended to start recording a log file before analysis begins. 

 If a high value of epochs is selected, the display of data in real-time cannot be guaranteed, 

especially when graphical views are open. 

3.2.6 Relations between modes 

The operating mode depends on the status of the log file player. Modes are changed by user actions. Each mode 

has different states that are changed by a user action or by an event (Figure 8). 

In Online and Record modes, u-center displays data from the receiver. In Player mode data from a log file is 
displayed. Player mode has different states. In Play state messages are read and displayed periodically from the 

log file. The very intuitive user interface is derived from that of a CD player. u-center updates the views after 

each message. Step state only gets one message from the log file and immediately returns to paused Play state. 
Scan state also reads messages periodically but the display is only updated when paused or by changing the 

state. Position can be set in a log file. This behaves differently in the Player and Stop modes. In Stop mode the 

position is just set and no data is read and displayed. u-center will start recording or playing from that position 
when changing the mode. If position is set in Player mode, u-center will load the data up to this position from 

the log file and display the contents. 
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4 Menu structure 

4.1 Main frame 

The Main Frame is the primary display screen of u-center. It displays all tool bars and some of the information 

provided by the device. In the status bar, information about communication, UTC time, Operating Time, used 

protocol (NMEA or UBX), used file, etc. is shown. 

 Button Function: A description about each button in the tool bars can be obtained by holding the mouse 

cursor over the button for a few seconds. A Tool Tip message will appear near the Icon with additional 

information while a detailed description is displayed in the Status Display. 

 

 

 

  

 

  

 

 

 

 

 Status Display: display the current action or the function of a button if the mouse cursor is over the button  

Status Display 

Protocol Information 

Player Tool Bar 

Menu Bar Mouse Cursor 

Views Tool Bar 

Standard Tool Bar 

Button Function 

Receiver Tool Bar 

Communication Information 

UTC Time 

AssistNow Online 

Tool Bar 

AssistNow Offline 

Tool Bar 

Configuration 

String Tool Bar 

Hot/Warm/Cold 

Start Tool Bar 

u-blox 6 / u-blox 5 / Antaris Mode 
Operating Time 

File in use 
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 u-blox 6 / u-blox 5 / Antaris Mode: u-center automatically detects the type of device connected and 
activates the appropriate mode of operation in order to take optimal advantage of the features. The mode 

can also be manually selected through the menu bar.  

 File in use: As soon as a file is used (this file must first be opened) the name of the file will be displayed 
(xxxxxx.ubx) 

 Protocol Information: This box indicates the current message set that is being used to communicate with 
the device. This can be the NMEA-0183 standard or the UBX protocol. The UBX protocol provides more 

extensive information with the receiver. u-center can handle both protocols.  

 Operating Time: The time elapsed since you started u-center 

 UTC Time: The current time sent by the device 

 Communication Information: Shows the active COM port and baud rate. 

Color-Coding of this icon:  
 Green: data is being received at the correct baud rate 

 Dark Green:  the last data received was valid, but there is no data to collect at this time. 

 Red:  data is being received but errors are detected 

 Dark Red: no data is being received but errors have been detected in the past 

 Gray:  waiting for first data 

 

  

Figure 12: u-center and GPS/GNSS device are synchronized (green plug) 

 

Figure 13: u-center and GPS/GNSS device mismatch (red plug) 

4.2 Menu bar 

All u-center functions can be accessed through the Menu Bar, alternatively it may be easier to use the icons in 
the tool bars. 
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4.3 File menu and standard tool bar 

 

Figure 14: Standard Toolbar 

 

                                   

 

Figure 15: File Menu(s) with corresponding toolbar icons 

New…  u-center can capture receiver output data into a logfile. However, logging will only start 
after Record in the Player Menu has been selected. The elapsed logging time is displayed 

in the field operating time. The log files have a ‘ubx' extension. 

Save…  Opens a new logfile, saves the data from a ring buffer to the logfile and immediately starts 
recording all newly received data. This is useful when error or an unexpected event 

occurred and no log file was recorded. The size of the ring buffer (4 MB) is large enough 

to retain the data for the last hour (approx.). 

Open…  Opens a stored log file to be replayed. 

Close  Closes the log file. 

Database Empty All stored values are deleted.  

Empty database 
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Database Export Stored u-center logfiles can be converted into HTML or KML data formats for display with 
Google Map and Google Earth.  

Recent Files  A list of the most recent log files. 

Exit  Terminates u-center. 

4.4 Edit menu 

The Edit Menu is fully Windows
®
 compliant. 

4.5 View menu and views tool bar  

4.5.1 Packet console 

The Packet Console lists all incoming messages and provides information about message length and type.  

 

Figure 16: Packet console 

Refer to Table 4 for an explanation of the icons and text fields. 
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4.5.2 Binary console 

The Binary Console lists all incoming messages in binary and ASCII format.  

 

Figure 17: Binary console 

Refer to Table 4 for an explanation of the icons and text fields. 
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4.5.3 Text console 

The Text Console displays the content messages in textual form such as UBX-INF or NMEA messages. 

NMEA messages are shown with heading $Gxyyy, where x stands for the satellite system (L=GLONASS N=GNSS 

P=GPS) and yyy for the type of message (e.g. ZDA=Time & Date). 

 

Figure 18: Text console displaying UBX-INF and NMEA messages 

 

Figure 19: Text console displaying only RMC messages 
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Element Name Description 

  
Lock Prevents the Text Console from being updated with new data 

when locked. 

 
Clear All Erases all data in the Text Console 

 
Filter On/Off Filter unwanted data from the data stream. This allows searching 

for certain expression, e.g. all RMC messages (Figure 19). 

Table 4: Description of the buttons of the different Consoles 

4.5.3.1 Regular expression evaluation 

Normally, when you search for a sub-string in a string, the match should be exact. So if we search for a sub-

string "abc" then the string being searched should contain these exact letters in the same sequence for a match 
to be found. We can extend this kind of search to a case insensitive search where the sub-string "abc" will find 

strings like "Abc", "ABC" etc. That is, the case is ignored but the sequence of the letters should be exactly the 

same. Sometimes, a case insensitive search is also not enough. For example, if we want to search for numeric 
digit, then we basically end up searching for each digit independently. This is where regular expressions come in 

to our help. Regular expressions are text patterns that are used for string matching. Regular expressions are 

strings that contain a mix of plain text and special characters to indicate what kind of matching to do. Here's a 
very brief tutorial on using regular expressions.  

Suppose, we are looking for a numeric digit then the regular expression we would search for is "[0-9]". The 

brackets indicate that the character being compared should match any one of the characters enclosed within the 
bracket. The dash (-) between 0 and 9 indicates that it is a range from 0 to 9. Therefore, this regular expression 

will match any character between 0 and 9, that is, any digit. If we want to search for a special character literally 

we must use a backslash before the special character. For example, the single character regular expression "\*" 
matches a single asterisk. In the table below the special characters are briefly described. A regular expression 

search is case sensitive. 

Character Description 

^ 
Beginning of the string. The expression "^A" will match an ‘A’ only at the beginning of the 

string. 

[^ 

The caret (^) immediately following the left-bracket ([) has a different meaning. It is used to 

exclude the remaining characters within brackets from matching the target string. The 

expression "[^0-9]" indicates that the target character should not be a digit. 

$ 
The dollar sign ($) will match the end of the string. The expression "abc$" will match the sub-

string "abc" only if it is at the end of the string. 

| 
The alternation or logic OR character (|) allows either expression on its side to match the target 

string. The expression "a|b" will match ‘a’ as well as ‘b’. 

. The dot (.) will match any character. 

* 
The asterisk (*) indicates that the character to the left of the asterisk in the expression should 

match 0 or more times. 

+ 
The plus (+) is similar to asterisk but there should be at least one match of the character to the 

left of the + sign in the expression. 

? The question mark (?) matches the character to its left 0 or 1 times. 

() The parenthesis affects the order of pattern evaluation. 

[] 
Brackets ([ and ]) enclosing a set of characters indicates that any of the enclosed characters may 

match the target character. 

4.5.3.2 Example 

Let’s assume that the following lines would appear in the NMEA console without filtering.  
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14:00:03 $GPGGA,140003.242,4717.1126,N,00833.7862,E,1,06,1.3,543.0,M,,,,0000*09 

14:00:03 $GPGLL,4717.1126,N,00833.7862,E,140003.242,A*34 

14:00:03 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2.9,1.3,2.6*3A 

14:00:03 $GPGSV,2,1,07,06,58,062,44,17,52,161,44,25,45,239,44,22,35,301,44*7F 

14:00:03 $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E 

14:00:03 $GPRMC,140003.242,A,4717.1126,N,00833.7862,E,0.03,80.59,010201,,*36 

14:00:03 $GPVTG,80.59,T,,M,0.03,N,0.1,K*56 

14:00:04 $GPGGA,140004.242,4717.1126,N,00833.7862,E,1,06,1.3,542.0,M,,,,0000*0F 

 

14:00:04 $GPGLL,4717.1126,N,00833.7862,E,140004.242,A*33 

14:00:04 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2.9,1.3,2.6*3A 

14:00:04 $GPGSV,2,1,07,06,58,062,45,17,52,161,44,25,45,239,44,22,35,301,44*7E 

14:00:04 $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E 

14:00:04 $GPRMC,140004.242,A,4717.1126,N,00833.7862,E,0.02,152.96,010201,,*0D 

14:00:04 $GPVTG,152.96,T,,M,0.02,N,0.0,K*6B 

In the following examples the characters marked red match the regular expression. 

 

Example 1: Searching for the RMC with a valid position and all GGA Messages 

“GP(GGA|RMC,.*,A,)” 

 

14:00:03 $GPGGA,140003.242,4717.1126,N,00833.7862,E,1,06,1.3,543.0,M,,,,0000*09 

14:00:03 $GPRMC,140003.242,A,4717.1126,N,00833.7862,E,0.03,80.59,010201,,*36 

14:00:04 $GPGGA,140004.242,4717.1126,N,00833.7862,E,1,06,1.3,542.0,M,,,,0000*0F 

14:00:04 $GPRMC,140004.242,A,4717.1126,N,00833.7862,E,0.02,152.96,010201,,*0D 

 

 

Example 2:  Searching for all GSV with the message index of ‘2’ or ‘3’ 

“GSV,.*,[2-3],” 

 

14:00:03 $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E 

14:00:04 $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E 

 

Example 3:  Searching for all messages starting with $GP, which have a ‘G’ in the message identifier but not 
at the first position  

“^\$GP.+G.*,” 

 

14:00:03 $GPGGA,140003.242,4717.1126,N,00833.7862,E,1,06,1.3,543.0,M,,,,0000*09 

14:00:03 $GPVTG,80.59,T,,M,0.03,N,0.1,K*56 

14:00:04 $GPGGA,140004.242,4717.1126,N,00833.7862,E,1,06,1.3,542.0,M,,,,0000*0F 

14:00:04 $GPVTG,152.96,T,,M,0.02,N,0.0,K*6B 

 

 

Example 4:  Searching for all message having a checksum of which the higher nibble is 3 

“\*3.$” 

 

14:00:03 $GPGLL,4717.1126,N,00833.7862,E,140003.242,A*34 

14:00:03 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2.9,1.3,2.6*3A 

14:00:03 $GPRMC,140003.242,A,4717.1126,N,00833.7862,E,0.03,80.59,010201,,*36 

14:00:04 $GPGLL,4717.1126,N,00833.7862,E,140004.242,A*33 

14:00:04 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2.9,1.3,2.6*3A 
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4.5.4  Messages view 

The Messages View is utilized to communicate with the device. Receiver output messages (e.g. navigation 

output, status and debug information) are displayed; input messages (e.g. configuration messages) can be sent. 

There are different sections for NMEA and UBX protocol.  

 

 

Figure 20: Message View 

Element Name Description 

  
Lock Prevents the Message View from being updated with new data 

when locked. 

 
Clear All Erases the entire Message View. 

 
Send Sends the current message to the device. 

 
Poll Polls the selected message once. 

 
Auto poll Automatically polls a newly selected message once  

 
Message Hotkey Assigns a hotkey to the selected message 

Table 5: Description of the buttons in the messages view 

 

Hex Dump  

Displays the mes-
sage content in 

hexadecimal and 
ASCII form. 

Message Display  

Displays the mes-
sage content. 

Message Tree 

A list of all NMEA 
and UBX message 

Gxyyy shows active 

message (GLyyy, 
GNyyy or GPyyy) 

Toolbar 
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4.5.4.1 Receiver output messages 

 

 

Figure 21: Message display of an output message 

 Double-clicking on an output message enables or disables the periodic message update if the 
communication protocol is active. This feature is currently only supported for the UBX protocol. 

4.5.4.2 Receiver input messages 

Input messages can be edited and sent to the device from the Message View. It is also possible to poll the 

current receiver settings.  

 

Figure 22: Message display of an input message 

 u-center performs some range checks on input messages. If an input value exceeds the permitted range, 
u-center will highlight the field in red but it is still possible to send the value to the receiver. However, the 
receiver is likely to reject such a message. 

 

Last Update  

Time in seconds 

since last update. 

Message Content  

Selected Message 

Blue shaded if mes-

sage has been 
received from the 

GPS recently 

otherwise grey. 

Hex Dump  

Last Update  

Time in seconds 

since last update 

(sending or polling) 

Selected Message 

Blue shaded if mes-

sage has been 

received from the 
GPS recently 

otherwise grey. 
Hex Dump  

Message Content  

Message Tree 

Black messages 
have recently been 

updated; grey 

messages have not 
been updated. 
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4.5.5 Configuration view 

The Configuration View is a subsection of the Message View and shows only those messages related to 

configuration (see Figure 23). 

 

Figure 23: Configuration view 
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4.5.6 Statistic view 

All available GPS values (transmitted from the device or calculated by u-center) are displayed. The following 

statistics are displayed: 

 Current Value 

 Minimum Value 

 Maximum Value 

 Average Value 

 Standard Deviation  

 

Figure 24: Statistic view 

 Choosing Database Empty in the File Menu or pressing the Button  deletes the Statistic View. 

 The content of the Statistic View can easily be exported to other programs using Copy/Paste. 

4.5.7 Table view 

All values from the database can be displayed in a tabular form (Figure 25). This is very useful when analyzing 

the logfile in detail. 

 

Figure 25: Table view 

To add a new column, first select the desired value (Figure 26) and click the + Button. To remove a displayed 

value, click the – Button. To see the Table header click the  Button. 

Grey color: the value was not set for the current epoch 

Blue Color: the value was calculated by the application from other data 

Empty field: data is not available  
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Figure 26: Selecting a new value 

 The number of displayed epochs is set to 1800 by default (see also section 3.2.5 Database limitation). 

 Choosing Database Empty in the File Menu or pressing the Button  deletes the Table View. 

 The content of the Statistic View can easily be exported to other programs using Copy/Paste. 

 

With the function Recent table view one of the last 8 used tables can be selected (Figure 27) and displayed. 

 

Figure 27: Recently used tables 

Empty field: data is not available  
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4.5.8 Google Earth 

u-center features a Google Earth view and enhanced kml export for visualizing position and tracks with Google 

Earth (see Figure 23).  

 

Figure 28: Google Earth view 

 To use the Google Earth View acceptance of the Google Map API Terms of Service is required. 
http://code.google.com/apis/maps/terms.html 
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4.5.9 Map view 

u-center can display positions on pre-calibrated maps (Figure 29). This allows a basic analysis of road tests. 

 

Figure 29: Displaying a position  

4.5.9.1 Using map view 

You can access the view specific commands in two different ways: 

 Using the command in the Tool Bar below the Map View. 

 Holding the cursor inside the Map View and pressing the right mouse button will. This will open a context 

menu: 

 

Zoom Factor   Adjust Colors 
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Element Name Description 

 

Cursor The position of the cursor is shown on the lower left edge of the 

u-center screen (Longitude, Latitude and Pixel-Position). By 
holding the left mouse button and moving the cursor over the 

map you can measure distance from one position to another 

 
Move The map inside the Map View Window can be moved 

 
Zoom In The map is enlarged by selecting a rectangle 

 
Zoom Out The size of the Map is decreased 

 
Zoom Factor Different specific zoom level can be selected  

 
Drawing Mode The size and form of the displayed position can be changed; the 

connection line between the points can be selected in the menu 

Connect. To see statically values (average, minimum, maximum, 

standard deviation) directly in the map, select the Menu Statistic.  

 
Fit Map The map size is adjusted to fit the Map Window 

 
Follow Center the map on the current GPS position 

 
Markers Add or remove the defined markers (see also 4.5.9.3, Map 

calibration) 

 
Open Map  Load a new or one of 8 recently used maps.  

 
Save Map View The current display can be stored in different formats 

 
Adjust Colors Brightness, contrast and color saturation of map can be adjusted 

by moving the glides 

Table 6:  Description of the buttons and displays in map view  

 Map Views can be copied to the clipboard using the ‘Print Screen’ function. 

 Choosing Database Empty in the File Menu or pressing the Button  deletes all recently displayed 

positions and routes. 
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4.5.9.2 Application example: Reviewing a road test 

 Open a u-center logfile (refer to Section 4.3). 

 In the Player Menu or player Tool Bar   select the menu Play or 

click the button . Deactivate in the Player Menu Pause or click the button . 

 Now, the stored positions are displayed (Figure 30). 

 

Figure 30: Logfile from a road test 

4.5.9.3 Map calibration 

To create your own map you will need a digitized map or pictures with orthogonal projection in one of the 

following pixel graphics formats.  

 png Portable Network Graphics,  

 bmp Windows Bitmap 

 dib   Device Independent Bitmap  

 gif  Graphics Interchange Format 

 jpg/jpeg Jpeg File Interchange Format 

 pcx  PC paintbrush 

 tif  Tag Image File Format 

If your map is not in one of the above formats, you can simply convert it in one of the supported formats by a 

third party program. u-blox provides two sample maps. Office.png is a small map of the surroundings of the u-

blox headquarters. World.png is a map of the whole world but with limited resolution. 

To use a map in u-center, three calibration points are needed. For these points you have to know the pixel 

coordinates and the according WGS84 coordinates in the latitude/longitude format in degrees (longitude: -180.0 

to 180.0, latitude: -90.0 to 90.0). These points are stored in the map calibration file. The calibration file must be 
stored at the same location as the bitmap itself. It has the same name but a different extension (*.mcf). The 

Format of the calibration file is very simple and can be edited in a simple editor like notepad.  
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Examples: 

As an example we will have a closer look at the provided map 'world.png' and its calibration file 'world.mcf'.  

 

       

Digital map file: world.png 

The Map has 1765 Pixels (0 to 1764) in the horizontal and 1046 Pixels (0 to 1045) in the vertical direction. The 

origin is the upper left corner. To calibrate this map we will use the following three calibration points (#1 to #3). 

 

  Pixel WGS84 Coordinate 

Reference Point  # X Y Longitude Latitude 

Upper Left Corner 1 0 0 -180.0 90.0 

Lower Right Corner 2 1764 1045 180.0 -90.0 

Upper Right Corner 3 1764 0 180.0 90.0 

 

To determine the exact pixel position you can use Microsoft Paint (mspaint.exe) or any other pixel-editing 

program. 

The calibration file is a plain ASCII text file. The file may contain comments. The file consists of two sections, 
which start with keywords encapsulated in braces. 

The REFERENCE section, which is mandatory, contains the three points used to calibrate a map. Each reference 

point is on a single line and has the following syntax: 

“# = <x>, <y>, <lon>, <lat>” 

where # is the index of the reference point <x> is the horizontal and <y> is the vertical image coordinate and 
<lat> is the Latitude and <lon> is the Longitude in degrees and WGS84. 

The optional MARKER section defines additional points on the map. Each point is on a single line with the 

syntax: 

“# = i, <x>, <y>[, <text>]” or “# = c, <lat>, <lon>[, <text>]” 

where # is the index of the marker point <x> is the horizontal and <y> is the vertical image coordinate or <lat> 
is the Latitude and <lon> is the Longitude in degrees and WGS84. <text> is a optional string in quotes labeling 

the marker point. The points must have a unique index from 1 to <num>. The maximum marker point index 

<num> is written to the same section on a separate line with the syntax “Count = <num>”. 

Y/X 
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; I N F O 

; ------------------------------------------------------------ 

; File:   world.mcf 

; Source: (sample data set) 

 

 

; R E F E R E N C E  

; ------------------------------------------------------------ 

; 3 Points must be defined to calibrate a Map 

; Parameters: 

;   #       = index of the point (1 to 3) 

;   x,y     = image coordinates 

;   lat,lon = world coordinates 

; Syntax:  

;   # = <x>, <y>, <lon>, <lat> 

 

[REFERENCE] 

1 =    0,     0,  -180.0,  90.0 

2 = 1764,  1045,   180.0, -90.0 

3 = 1764,     0,   180.0,  90.0 

 

 

; M A R K E R 

; ------------------------------------------------------------ 

; You can add points (image or world coord) to the map   

; Parameters: 

;   num     = number of markers that follow 

;   #       = index of the point (1 to num) 

;   type    = c for world or i image coordinates 

;   x,y     = image coordinates 

;   lat,lon = world coordinates 

;   text    = quoted text decription to the marker (optional) 

; Syntax:  

;   Count = <num> 

;   #     = <type>, <x|lon>, <y|lat>[, <text>] 

 

[MARKER] 

Count = 1 

1 = c, 8.56525, 47.28519444, "u-blox ag" 

 

Map calibration file: world.mcf 
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4.5.9.4 Map calibration tool 

u-center includes a built-in calibration tool for providing coordinates to maps and photographs in supported data 

formats to create u-center maps. To use the tool open the Map View window as seen in Figure 31 and then as 

seen in Figure 32 open the file of the map to be calibrated (in our example GoogleScreenShot.bmp). 

 

Figure 31: Opening map view window 

 

Figure 32: Opening the file of the map to be calibrated 

If the file to be opened has not been calibrated, the following message will appear: 
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Select three points on the map and enter the calibration coordinates in the specified format as seen in Figure 33, 
Figure 34 and Figure 35. 

 

Figure 33: Calibrating a map using calibration tool (position 1) 

 

Figure 34: Calibrating a map using calibration tool (position 2) 
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Figure 35: Calibrating a map using calibration tool (position 3) 

Following these steps the map is now calibrated and can be used with u-center for visualizing road tests etc.  

 

4.5.10 Chart view 

Chart View allows the user to conveniently view GPS-Data records in graphical form. The data can be scaled in 

many different ways and formats. It’s even possible to print the entire chart. 

The examples below illustrate 3 different typical applications 

 

Figure 36: Altitude as a function of Index (X = Index, Y = Alt) 
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Figure 37: Index as a function of altitude (X = Altitude, Y = Index) 

 

Figure 38: Latitude as a function of longitude (X =Longitude, Y = Latitude) 
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Element Name Description 

 
Cursor The cursor position is shown in the lower left edge of the u-

center windows. Click the right button mouse and hold the 
button down to measure differences. 

 
Move The chart is moved inside the Chart View Window. Click and 

Drag/Drop the Chart. 

 
Zoom In Drawing a rectangle enlarges the chart to the new view. To zoom 

in the Chart 2x click on the chart 

 
Zoom Out Drawing a rectangle decreases the chart to the new view. To 

zoom out the Chart 2x click on the chart 

 
Drawing Mode The size and form of the displayed values can be changed in the 

menu points; the connection line between the values can be 

selected in the menu Connect. For viewing the statically values 

(average, minimum, maximum, standard deviation) directly in the 
chart select the Statistics Menu 

 
Fit Y Fit the Y Range 

 
Follow Y Follow the most current Y-Value (the most current Y-value is 

always in the middle of the chart) 

 
Index or Y Value Switch between the Index and the Y Value 

 
Y Value Select the Y Value to be displayed 

 
Fit X Fit the X Range 

 
Follow X Follow the most current X-Value (the most current X-Value is 

always in the middle of the chart) 

 
Index or X Value Switch between the Index and the X Value 

 
X Value Select the X Value to be displayed 

 Moving Average Adds a moving average. The average is calculated over the 

number of most recent values, specified with the parameter. 

Table 7: Description of the buttons and displays in Chart View  

 The number of displayed epochs is set to 1800 by default (see also section 3.2.5). 
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4.5.11 Histogram view 

Histogram Views allow the user to view GPS-Data and probability distributions (Figure 39) and print the entire 

histogram if desired. The number of bins (storage containers) can be set by the user.  

 

Figure 39: Altitude Histogram View 

 

Figure 40: Probability chart 

 The number of displayed epochs is set to 1800 by default (see also section 3.2.5). 
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Element Name Description 

 
Cursor The cursor position is shown in the lower left edge of the u-

center windows. Click the right button mouse and hold the 

button down to measure differences. 

 
Move The Histogram is moved inside the Histogram View Window. 

Click and Drag/Drop the Histogram. 

 
Zoom In Drawing a rectangle enlarges the Histogram to the new view. To 

zoom in the Histogram 2x click on the Histogram 

 
Zoom Out Drawing a rectangle decreases the Histogram to the new view. 

To zoom out the Histogram 2x click on the Histogram 

 
Drawing Mode The size and form of the displayed values can be changed in the 

menu Points. The connection line between the values can be 

selected in the menu Connect. For viewing the statically values 

(average, minimum, maximum, standard deviation) directly in the 
Histogram select the Statistics Menu 

 
Probability Display the probability Histogram (Figure 40) 

 
Fit Probability Fit the Probability Range 

 
Fit X Fit the X Range 

 
Y Value Select the Y Value to be displayed 

 
Bins The number of Bins 

Table 8: Description of the buttons and displays in histogram view 
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4.5.12 Camera view 

The Camera View  function enables photographs, taken during recording of log files, to be linked to the GPS 

data stored in the corresponding log files. This allows a video depiction of the test, with a picture assigned to a 

specific point of GPS data. 

 

Figure 41: Camera view 

 

 Using Camera View can result in very large logfiles and can slow down u-center when playing such files. 
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4.5.13 Deviation map 

The Deviation Map displays positions in longitude and latitude relative to a defined reference position.  

 

Figure 42: Deviation Map 

Element Name Description 

 
Properties The Reference Position can be defined as:  

The average of all previously measured positions 

The current position 

A fixed, predefined value  

The radius of the outer circle can be adjusted with the Max. 

Deviation parameter. 

 
Fit Automatically adjusts the Reference Position and the Max. 

Deviation to fit all positions into the Deviation Map. 

 
Track  

 
Statistics  

Table 9: Description of the buttons and displays in Deviation Map 

 The number of displayed epochs is set to 1800 by default (Section 3.2.5). 
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4.5.14 Sky view 

Sky View is an excellent tool for analyzing the performance of antennas as well as the conditions of the satellite 

observation environment. The polar plot graphically displays the averaged relative satellite signal strength (Figure 

43), the position of satellites in the sky, identifies satellites by number and indicates which satellites are being 
used in the receiver calculation (see Section 3.1). Right-clicking the mouse on Sky View allows the copying of 

C/No values in tabular form to another program. 

 

Figure 43: Sky view 

Element Name Description 

 
Linear Selects a linear projection of the Sky View 

 
Sine Selects a sinusoidal Projection of the Sky View 

 
C/No Displays the averaged C/No values 

 
Orbits Displays the orbits of the satellites 

 
SVs Displays the current position of the satellites 

 
Coord. Adds a caption for the azimuth 

 
Elevation Adds a caption for the elevation 

Table 10: Description of the toolbar in Sky View 
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4.6 Receiver menu and receiver toolbar 

 

Figure 44: Receiver menu with corresponding icons from receiver toolbar 

In order to communicate with a GPS/GNSS device, u-center must have the correct COM port settings. Please 

refer to Section 2.4 for a description of the settings. 

 Only the COM Ports, that are available on your computer, will show up in the COM Port drop down list. If 
a COM Port is grayed out, another application on the computer is using it. 

4.7 Action toolbar and menu 

 

 

The Action toolbar and menu are used to command the receiver to perform a Cold-, Warm- or Hotstarts, or to 
implement the AssistNow Online Aiding (A-GPS) function. Visit our website at http://www.u-blox.com/ for more 

information about AssistNow Online. In order to take advantage of AssistNow Online, customers must register 

with u-blox. Please contact your nearest u-blox sales office to get access details.  

4.8 AssistNow Offline toolbar and menu 

                   

                   

http://www.u-blox.com/
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The AssistNow Offline Toolbar and menu is used to download AlmanacPlus aiding data for A-GPS. AlmanacPlus 

data files are available in various sizes to provide aiding for periods of 1 to 14 days. Visit our website at 

http://www.u-blox.com/ for more information about AssistNow Offline. 

4.9 Player menu and player toolbar 

 

 

     Goto Position 

The primary function of the Player is to display previously recorded GPS data from a file. Refer to Section4.3 for a 

description on how to create or open a log file. Using the player controls, you can step through or play all 
messages from the log file. The series of buttons in the player toolbar can be used to navigate through the log 

file. The records will be displayed on the navigation display window, in the same way that live GPS data is 

displayed when using u-center. The current file that is being displayed is shown in the box “File in use”. 

http://www.u-blox.com/
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Element Name Description 

 
Eject Close the active log file 

 
Stop Stops displaying or recording to the active log file 

 
Pause Pauses displaying or recording to a log file 

 
Record Starts recording to the previously created logfile. If a log file is not already open, 

you will be prompted to start a new file; any data already captured in the ring 
buffer will be discarded. If you want to save this data in the log file, open the File 

menu and click Save. 

 
Step Single step function, the next message is read 

 
Play Starts to display a log file. You can select the speed of the action. After each 

message the display is updated as required 

 
Scan Reads the entire log file into the database and updates the display at the end of 

the scan period 

 
Go to Begin Set the read path to the begin of the log file 

 
Go to End Go to the end of the log file 

 Go to Position This slider bar is used to shuttle back and forth through the history log. Pulling 
the slider to the right will fast-forward the playback, and pulling it to the left will 
rewind the playback 

Table 11: Description of the buttons and the slider in the Player Toolbar 

4.10 View menu: docking windows 

The Docking Windows are graphic displays, which provide real-time information about the device. These are the 
most commonly used windows for u-center users. Eight different panes can be displayed: receiver status, satellite 

and signal strength information, position on a world map and 4 analog dials. The windows can be resized, 

closed or moved anywhere on the screen. Refer to Section 3.1 for an explanation about the color codes. 

To open these windows, select Docking Windows from the View menu, or simply click on the icons on the 

View tool bar.  
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Satellite Position 

Displays the position 
of satellites in the 
sky 

Satellite Level 

Displays Elevation, 
Azimuth and C/NO 
(dBHz) for SVs 

World Position 

Displays the current 
Position on a world 
map 

Watch 

Displays the date 
and the current 
UTC-Time 

Altitude Meter 

Displays the current 
altitude 

Compass 

Displays the current 
course over ground 

Speed Meter 

Displays the current 
speed  

Receiver Status 

Displays a summary 
of the receiver 
status. 

 

Figure 45: Docking Windows 

4.11 Tools menu 

4.11.1 Firmware update (u-blox 6 and u-blox 5)  

The receiver firmware can be updated with the firmware update function in the Tools Menu. 

1) Establish the serial communication between u-center and the device (see also section 2.4). 

2) On u-center open “Tools” / “Firmware Update u-blox 5/6…”. 

3) Select the path of the Firmware image and Flash definition file (see Figure 46) 

4) Select the update mode "USB alternative update method" if you're using the USB port or "Enter Safeboot 
before update" with UART. 

5) If the connection is with UART, select the download baud rate. This is the baud rate used during the 

firmware download. The default value is 115200 baud. The lower this baud rate, the longer a firmware 
update takes. 

6) Select "Erase whole Flash" only if you want to delete all stored configuration and factory settings. 

7) Click on “OK” 
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Figure 46: u-blox 5 Firmware update window 

4.11.2 Firmware Update (ANTARIS 4)  

The receiver firmware can be updated with the firmware update function in the Tools Menu. 

1) Establish the serial communication between u-center and the device (see also section 2.4). 

2) On u-center open “Tools” / “Firmware Update Antaris …”. 

3) Select the path of the ‘prodstub’ (ATR0620l.exe) and the firmware image. 

4) Select the ‘Production Mode’. ANTARIS
®
 based GPS receivers can be put into boot mode by sending a UBX 

protocol command. If the device connected to u-center is configured for UBX protocol input, choose the 

‘use serial port’ option. Otherwise, select ‘use bootmode pin’ and put the receiver manually into boot mode. 

5) Check the COM port (u-center automatically initializes the COM port with the u-center COM port). 

6) Select the download baud rate. 

7) If ‘Production Mode’ is set to ‘serial port with UBX protocol’, check the UBX protocol baud rate (u-center 

automatically initializes it with the u-center baud rate.). The UBX protocol baud rate is only used to enter the 
download process. 

8) Initiate the download by pressing the ‘Update’ button. The device will be reset automatically after the 

download. 
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Figure 47: ANTARIS Firmware update window 

4.11.3 Dump receiver diagnostics  
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4.11.4 GPS configuration  

u-center is capable of getting the actual configuration of a u-blox GPS/GNSS positioning chip or module and 

storing it to an ASCII text file containing hexadecimal records. Such a file can be edited and stored to a u-blox 

GPS/GNSS device again. By clicking the menu “Tools -> GPS Configuration...” of u-center, the GPS 
Configuration dialog opens. The following functions are available: 

  

Figure 48: Screenshot, u-center GPS configuration 

 Specify the name of a new configuration file to store current configuration from the u-blox GPS/GNSS device 

 Specify the name of an existing configuration file and load this configuration into the u-blox GPS/GNSS 

device 

 A flag can be set to force storing the configuration into the Battery Backed RAM (BBR) or Flash EPROM. 

4.11.4.1 Read/Write configuration files 

1. Connect to the device. 

2. Open Tools / GPS Configuration. 

3. To read an existing configuration file, select the name of the file, then click on “File>>GPS” button. The GPS 

Configuration window then closes and the progress window pops up, showing the configuration being sent 
to the receiver. This progress window closes after finishing the transfer without error. 

 Select “store configuration into BBR/Flash” checkbox if the parameters need to be stored into the device’s 

non-volatile memory (BBR/Flash). 

 Sending a configuration to a u-blox GPS/GNSS device may fail due to a baud rate change on the current 
serial port of the receiver to which the the configuration is being sent. If this happens, simply change the 

u-center baud rate and send the configuration again. 

To write a new configuration file, click on “GPS>>File”. The GPS Configuration window closes and the progress 
window pops up, showing the configurations being polled and stored into a local file in ASCII format. 

If reading or writing configuration data fails too frequently, try to increase the number of retries u-center should 

do on a single message if one fails. 

The user can abort the transfer by clicking the “Abort” button. It’s not possible to close the window unless 

transfer has completed or the user aborted it. 

 It is not recommended to read/write configuration while the u-blox GPS/GNSS device is in sleep mode. 
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4.11.4.2 Editing configuration file 

 

Figure 49: Content Configuration File 

When clicking the “Edit” button in the GPS Configuration dialog, the Notepad editor opens (standard Windows 

software). Configurations are stored the following way: 

 1
st
 line: it contains the version of the ANTARIS

®
 based GPS receiver where the configuration is from. Never 

change this line! 

 For the 2
nd
 line and following each line contains the same: <class ID>-<message ID> - <hexadecimal byte 

code of the message>. The byte code consists of class and message IDs (2 bytes), payload length (2 bytes), 
payload (payload length bytes). The sync characters and the checksum are not included. They will be 

calculated automatically.  

Please refer to u-blox 6 Receiver Description including Protocol Specification [3] for detailed information and 
ranges. 

4.11.5 Hotkeys 

The Tools Menu allows administrating the Hotkeys defined in the Message View. Please refer to Section 4.5.4 for 
more information on the Hotkeys. 

4.11.6 Preferences 

The Preferences tool can be used to configure a number of u-center parameters. 

 

4.12 Windows menu 

The Windows Menu is Windows
®
 compliant. 



u-center - User Guide 

GPS-SW-08007-C  How To 

  Page 53 of 60 

5 How To 

5.1 Change parameters (baud rate) 

1) Connect to the device. 

2) Open View / Message View. 

3) Select UBX – CFG - PRT 
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5.2 Save parameters to receiver non-volatile memory (BBR/Flash) 

There are 2 ways to save parameters to the receiver’s non-volatile memory (BBR/Flash). 

5.2.1 Saving parameters with UBX-CFG-CFG 

1) Connect to the device. 

2) Open View / Message View. 

3) Select UBX-CFG-CFG window. 

4) Select “save current configuration” (see Figure 50). 

 

Figure 50: Saving Parameters (UBX-CFG-CFG) 

5.2.2 Saving parameters with GPS configuration 

Refer to 4.11.4.1 step 3 
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5.3 Recording/playing a log file 

u-center allows recording and playing log files. Use the player controls, to record or playback a log file. Select the 

log file to be opened through the File Menu tool bar. The series of buttons in the player toolbar can be used to 
navigate through the log file. The records will be displayed on the navigation display window, in the same way 

that live GPS data is displayed when using u-center.  

 

 

  

Figure 51: u-center player toolbar 

New log files can also be created through the menu bar by selecting File/New. Figure 52 shows an example of a 

log file.  
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Figure 52: Example of a Log File 

5.4 Conduct sensitivity tests 

u-center is a useful tool for conducting sensitivity tests of GPS/GNSS positioning chips and modules and receiver 

designs. To do so, under open sky conditions record a log file of the receiver to be tested and an Evaluation Kit 

as reference. Make sure that the log files are recorded under the same conditions. Using the Statistic View or 
Table View windows from u-center, compare the C/N0 values of the five strongest satellites. With Table view, 

export the values to a spreadsheet for analysis. 

5.5 Read/write configuration files 

Refer to 4.11.4.1. 

5.6 Set GNSS system configuration 

1) Connect to the device. 

2) Open View / Message View. 

3) Select UBX-CFG-GNSS window. 

4) Place or remove the checkmark for the desired GNSS under “enable”. 

5) Click “Send” 
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The following Figure 53 shows an example that configures the device to receive only GLONASS. 

 

Figure 53: GNSS configuration (UBX-CFG-GNSS) 

5.7 Activating PPP (EVK-6PPP only) 

1) Connect to the device. 

2) Open View / Message View. 

3) Select UBX-CFG-NAVX5 window. 

4) Place or remove the checkmark for “Use PPP”. 

5) Click “Send” 

 

 

Figure 54: How to activate and deactivate PPP with UBX-CFG-NAVX5 
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6 Troubleshooting 
NMEA or UBX protocol is not available in the Message View 

u-center uses dynamic link libraries (DLL). The installation program will automatically install the required DLL’s 
into the u-center program directory. Should you try to copy a u-center installation from one location to another, 

make sure you also copy the DLL files. Verify, the version of u-center matches the DLL version. 

u-center doesn’t display all messages 

Make sure the baud rate is sufficient. If the bandwidth is insufficient, GPS receivers based on the ANTARIS™ GPS 

Technology will skip excessive messages.  

Some serial port cards/adapters (i.e. USB to RS232 converter) frequently generate errors. If a communication 
error occurs during while u-center receives a message, the message will be discarded. 

u-center loses the connection to the device 

u-blox GPS/GNSS positioning chips and modules have an autobauding feature. If frequent communication errors 
occur (i.e. due to problems with the serial port), the connection may be lost as u-center and the device will 

autonomously try to adjust the baud rate. Do not enable the u-center autobauding feature if the device has the 

autobauding enabled. 

Some COM port are not shown in the port list 

Only the COM Ports, that are available on your computer, will show up in the COM Port drop down list. If a 

COM Port is grayed out, another application in the computer is using it. 

PC is very slow when u-center runs 

If a high value of epochs is selected, the display in real-time can not be guaranteed, especially when many 

graphical Views are open. u-center does not update minimized Views and Console in real-time. Close or 
minimize as many of the graphical Views and Consoles as possible and u-center will run faster. 

Logfile / Data are only partly displayed 

The number of epochs displayed in u-center is limited in order to allow an efficient analysis of larger logfiles. The 
limitation is set to 1800 epochs by default. That means if an epoch is available every second you can analyze 

data for as much as 30 minutes. After this time the oldest values are discarded. Data stored to a logfile are not 

affected by the database limitation. Please refer to section 3.2.5 Database limitation for instructions on how to 
increase this limit. 

When planning long-term observations, it’s recommended to start recording a log file before analysis begins.  

Output messages are not updated in the Message View 

Make sure, the protocol you’d like to receive is enabled. If so, double-click on the desired output message. 

Double-clicking on an output message enables or disables the periodic message update if the respective protocol 

is active. Alternatively, select the desired input or output message and press the ‘Poll’ button. 

If you would like to get UBX-INF () messages in the log file, configure the receiver accordingly with the UBX-CFG-

INF input message. 

No logfile is recorded 

After a new logfile is created, logging will not automatically start but only after selecting the Record button in 

the Player Toolbar. 
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Related documents 
[1] GPS Compendium, Doc No GPS-X-02007 

[2] u-blox 5 Receiver Description including Protocol Specification, Docu. No GPS.G5-X-07036 

[3] u-blox 6 Receiver Description including Protocol Specification, Docu. No GPS.G6-SW-10018 

All these documents are available on our website (www.u-blox.com). 

 

 For regular updates to u-blox documentation and to receive product change notifications please register 
on our homepage. 

 

 

Revision history 
 

Revision Date Name Status / Comments 

- 08/10/2008 tgri Initial release 

A 22/07/2009 tgri New CI 

A1 17/02/2011 tgri Third party libraries 

B 1/11/2011 tgri Google Earth View added 

C 06/07/2012 khir Updated for u-center 7. 

 

 

http://www.u-blox.com/
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Contact 
For complete contact information visit us at www.u-blox.com 

 

Offices     

North, Central and South America 

u-blox America, Inc. 

Phone: +1 703 483 3180 

E-mail: info_us@u-blox.com  

Regional Office West Coast: 

Phone: +1 703 483 3184 

E-mail: info_us@u-blox.com 

Technical Support: 

Phone: +1 703 483 3185 

E-mail: support_us@u-blox.com 

 
Headquarters  
Europe, Middle East, Africa 

u-blox AG  

Phone: +41 44 722 74 44 
E-mail: info@u-blox.com  

Technical Support: 

Phone: +41 44 722 74 44 
E-mail: support@u-blox.com 

 
Asia, Australia, Pacific 

u-blox Singapore Pte. Ltd. 

Phone: +65 6734 3811 

E-mail: info_ap@u-blox.com 
Support: support_ap@u-blox.com  

Regional Office China: 

Phone: +86 10 68 133 545 
E-mail: info_cn@u-blox.com  

Support: support_cn@u-blox.com 

Regional Office Japan: 

Phone: +81 3 5775 3850 
E-mail: info_jp@u-blox.com  

Support: support_jp@u-blox.com  

Regional Office Korea: 

Phone: +82 2 542 0861 

E-mail: info_kr@u-blox.com  

Support: support_kr@u-blox.com 

Regional Office Taiwan: 

Phone: +886 2 2657 1090 

E-mail: info_tw@u-blox.com  
Support: support_tw@u-blox.com  

 

http://www.u-blox.com/
mailto:info_us@u-blox.com
mailto:support_us@u-blox.com
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